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2D Sheet

Key Points:

Create the various views for the parts and assemblies

Create/edit the dimension

Add the annotations and symbols (Datum, Feature Control Symbol, Surface Finish Symbol)
Create the text annotation

Create a BOM table and the Balloons

T

1.1 2D Sheet Introduction

In the process of product design and manufacturing, 2D sheet is an important and widely used

document even the 3D modeling is very visual.

With ZW3D to design the product 3D mode, then the associative 2D sheet can be generated.
When 3D model is changed, the 2D sheet is auto-updated.

1.1.1 Elements of 2D Sheet

Generally, the 2D sheet of a part consists of three parts:

1 Standard view (Top, Front, Right, Left, Bottom, Back and Isometric view),

Projection view, Section view, Detail view and so on.

2 Dimension (Shape dimension & Position dimension), Tolerance (Dimension
tolerances, Form tolerances & Position tolerances), Datum symbol, Surface finish

symbol and Text annotation.

3 Sheet format: Sheet border, Title block and so on.

2D sheet of an assembly includes many different views, assembly dimension, fit dimension,
BOM table and so on.
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Figurel 2D Sheet

1.1.2 Create a New 2D Sheet

Method1: In modeling environment, insert a new 2D Sheet by picking “2D Sheet” option from

Document Aware toolbars or the right menu located working area. Then select a template to
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create the new 2D sheet. At the same time, the standard view command is automatically
activated.

as-l¢ s -U-S-@-

& 2D Sheet
2 CAMPlan - i
= £
=2/ N Ejl ":
Select a t late... R qQ
¥ Select a template. (  SetRotation Center immerT g o
- Zoom All b
Al &%, | @ Part002.2D I I T r') T T i
[Defautt] Blanle entities g 4 B sheetl £3(H) (420.00 % 297.00 mm)
A0_H(ANSD A Insert Dotum ‘ﬁéh::t:;ma;xsﬁmsn
cet Border H a
AL_H(AN 2
e @ | Sketch [ Title Black
ALHENED V. 3D Sketch @ Teble
- = Config Table H | |
- ) J
A4 V(ANST) 4 ) Tt Insert Curve List
A_H{ANST & Insert Component L, |
AV(ANSD q'; Align
B_H(ANST)
C_H(ANSD ZW3D Manager... L |
D_HANSD %) Varioble Browser..
E_H{ANST) @@ Part Library __
A0_H(DIN) a 5
& 2D Sheet E
Al H(DIN) A = !
— 2 CAMPlan
oK Cancel I I I L] I I I
Customize

Figure2 Create a New 2D Sheet -Method1

Method?2: Click “New” command from the Ribbon toolbar, then select the file type “Drawing

Sheet” and drawing template. Give the name and click “OK” button, then the new 2D sheet is

created.
¥ Create New File B | Manager = 2+ Drawing00lZ3 X
Type ) # Drawing00l I I I r I I I
- — - | 4 B Sheetl A3(H) (420.00 x 297.00 mm)
@ Em c& < a ﬁéhe;‘t Fanma; A3_HANST) i ]
et
Part/Assembly Drawing Packet Drawing Sheetl__ Standalone Sketch et Borer

(i Title Block

_g z @ @ Table i |

CAM Plan Equation Set Multi-Object
- - 2
Template Information
All = Unique Name
AL_H{ANSD) “ | Drawing001.23 H H

|
A2_HANSD) T ﬁ
A3_H(ANST
—
e oK Cancel T I ¥

Figure3 Create a New 2D Sheet -Method?2

HID I

Method3: Click “New” command from the Ribbon toolbar, then select the file type “Drawing
Pocket” to create a drawing file. Then click “+” button to create a new 2D sheet in the file level.

Other operations are similar with Method?2.
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@ Create Mew File L=l acketlD1.73 X g
Type Add new object!
e 7
@ \% ¥ Create new [Drawing] =]
Part/Assembly Drawing Sheet Standalene Sketch
. Type
S 2 o )
CAM Plan Equation Set Multi-Object
Drawing Sheet
Template Information
hDEfE”It] | Unique Name
Packet001.73 Template Information
Description All ~ | Unigue Name
A2_H(ANST) 4 I;I Drawing001
A3_H(ANST) Description
Ad_H(ANSD
oK Cancel PP ul
G' oK Cancel

Figure4 Create a New 2D Sheet -Method3

1.1.3 2D Sheet Setting

1. In configuration form, some default parameters of drawing sheet can be modified. See the

image below.

@ Configuration 2 ER
.
General Drawing Sheet
Part Default auto-launch view creation command  Standard view T
0 Auto start projected view command
Col Auto generate the center mark for holes
olor
Auto generate the centerline for holes
Background
Auto generate the center mark for cylindrical and conical faces Min angle 130 - -
Display
Auto generate the centerline for cylindrical and conical faces Max angl 360 .
Files
CAM
User
PDOM =
Reset Default OK Cancel Apply

Figure5 Configuration Form

i,

L@
=

2. Tools ribbon toolbar->Setting-> FPreferences

Use this command to set some global drawing sheet settings, including units, mass units, grid

spacing and projection type.
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'@ Drawing Settings LD ER
Units mm o
Mass units kg =
Grid spacing 47
Type of projection | By Standard ’

Reset 0K Cancel

Figure6 Drawing Setting

3. Sheet Manager-> %) (ona sheet-‘)-> Attributes

Set the basic attribute of the selected sheet, such as sheet name, scale, paper color.

¥¥ Sheet Attributes = iR
Information
Sheet Mame Sheetl Scale | 1/1
Description | 20 Sheet for Baze part

Display paper color
Display sheet shadow

Start label
Mext section view label A
Mext detail view label A

Mext datum label A

Ok Cancel

Figure7 Sheet Attributes

f
4. Sheet Manager-> %) (on sheet format )-> Attributes

You can redefine or customize sheet format according to different requirements.
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# Base 2D
4 B Sheetl A4(H) (297.00 x 210,00 mm)
4|l Sheet Format Ad_H(ANST)
i Sheet Border L
(e Title Block p
W Table Add Additional List Block
> [ Drawing Viewl FRONT | . _
. @ Drawing View2 LEFT "% Add Code List Block

(0] ] ; ; —
> == Drawing View3 TOP L= Sheet Format Attributes

Expand Subitems
Collapse Subiterns
Figure8 Redefine Sheet Format Attribute

1.1.4 Customize 2D Drawing Template

Many different 2D Drawing templates are builtin ZW3D, such as, ANSI, ISO, GB, and DIN. But

many companies have their own templates to meet some customized requirements.

Generally, 2D drawing template customization includes three parts. Next, we will introduce

how to customize 2D Drawing template from an empty file.
1) Create a new 2D sheet and set 2D sheet size.
2) Define sheet format, including sheet border, title block and so on.
3) Set the layer, or style attribute if necessary.

Task1: Create a new 2D sheet

STEP 01| Confirm the object template file in use.

-
@ Configuration
General
Files
Part . .
Object template file Templates_MM.Z3
2D Default Part template
Color Default Sheet template
Background Default CAM template
Display Attribute bundles file Bundles.73 (
i Default session name Seszion
Files
Temporary folder Mtermnp
CAM

Figure9 Configuration Form
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STEP 02| Open the 2D drawing template file (File menu->Templates...), then create a new 2D
sheet with an empty template.

Manager Elo + [ Templates_MM.Z3 ¢
Filter All ~ Preview Off
Find i Name 5 @ Create new [Drawing] (=
MName Murmnber Type el Type
A0_H(AMNSI) Drawing @ m °$ ﬁ@)\
AD_H(DIN) Drawing =
AD_H(GB) Drawing Part/Assembly Drawing Packet Drawing Sheet Standalone Sketck
AD_H{IS0) Drawing = f_}éﬂ ¥
AD_H(IS) Drawing all ]
CAM Plan Equation 5et

Al _H(AMST) Drawing
A1 _H(DIN) Drawing
A1_H(GB) Drawing L Template Information
A1_H({S0) Drawing IA” | " Unique Name

o [Default] -
Al_H(I5) Drawing 10 HiaN = | zwsoeT
A2_H(ANSD Drawing -HIANSD -
A2 H(DIN) Drawing Al_H(AMST) Description

- . A2 _H{AMST)
A2 _H(GE) Drawing -
AD LIFARICTY
A2 _H(IS0O) Drawing
- [ A~ |

A2_HIS) Drawing e o] 4 Cancel
A3 HIAMSD Mrawinn

Figure1l0O Create a new 2D drawing
Task2: Define sheet format
In sheet manager, right click on sheet format, then select “Sheet Format Attributes”.
Sheet size: Select the standard size or enter the customized values in Width and Height fields.
Sheet Size < Custom= -

Width 300 Height 400

Figure1l Sheet Size

Sheet Border: Define the margin value of sheet border and partition value of trimming mark
and centering mark.

@ Custom margin 2 &3 S
Top s Use Border
Custom Margin
Bottom 5
Trimming Mark Centering Mark
Left 25
Partition
LA 5 Horzontal |4 Length 75.000
QK Cancel Vertical 4 Length 100.000

Figure12 Sheet Border
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Insert Block: Select a standard block type or predefined block type which is stored in
corresponding template file. Or don’t define it in here.

Preview
=
Insert block -
Title Title block_ZWSOFT = i
Code List Code_list_ZWSOFT -

Additional List <MNone=» -
[

Height: 400.0mm
Width: 300.0mm

Figurel3 Customized Block and Template Preview
Notes: All 2D drawing template files locate the resource folder of installation directory.

ZWSOFT » ZW3D 2017 Eng (x64) » resource »

Manager B 5%
Filter All ¥ Preview Graphic
_Find in Name

Name ) Name Type
TOOLS_METRIC_AND_INCH.Z3 PsiicetED Diniting
[& ToolHolderLib8.Z3 Jitie bickiR0) Drawing
ﬁ@ Templates_Title.Z3 | sy Title block(IS02) Drawing
T Templates. MM.Z3 Title block(1S01) Drawing
B Templates_IN.Z3 Title block(GB) Drawing
& Templates_Code_List.Z3 Title block(DIN) Drawing
Templates_Additional_List.Z3 Title block(ANSI_mm) Drawing
B Templates.Z3 Title block(ANSL in) Drawing

Figure14 2D Drawing Templates

db How to add the customized block in the template file, such as Title block?

STEP 01| Open the corresponding template file (Template_Title).

STEP 02| Create a new drawing sheet, and give a name such as “Title block ZWSOFT".
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0®Tem plates_TitleZ3 > @ 4+

@ Create new [Drawing] =2 ER

Type

Part/Assembly Drawing Packete Drawing Sheet Standalone Sketch
3 2
CAM Plan Equation Set

Template Information

All ~ | Unigue Mame

|[Defau|t] @ Title block_ZWSOFT

AD_H(ANSI) Descripticn

Al_H{AMSI) |

-
oK Cancel

Figure1l5 Create a New Drawing in the Template

STEP 03| In sheet manager, right click on sheet format, then click “Add Title Block” option. Then
draw the code list block in the sketch level.

Manager B X

@ . Title block_ZWSOFT
o BB Sheetl A4(H) (297.00 % 210.00 mm)
Sheet Format
B Table

Add Sheet Border

Add Title Block

Add Additional List Block
Add Code List Block

3 B D

E'I
| LB

Sheet Format Attributes

Figure1l6 Add Title Block Manually
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Part Unite Drawn

Name Designed

Part Scale Checked

Number Issued - 2 %

70
Process Projection 60
50

Material _f
| LZWSOFT COMPANY| ,
Quantity -

Size Sheet Version 1}31

fa—25 —=
50
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140
200

Figurel7 Draw Title Block in Sketching
STEP 04 In title block, create needed links with part attribute by text command.

With the variable browser you can browse all available variables, then select the

needed one to embed part attribute data in text strings. See the image below.

@‘u’ariableBrowser = E3
Part
Browsing this file
Name 0
Templates_Title.Z3 b
A Text £Z
v x i ] Browsing this object
¥ Required Title block_ZWSOFT
A P\. .A: Ohjects and variables
. m Part_Length -
bR -
1st point 33.038563.3469 ¢ e Part_Width
Teut | | & Part_Height -
C| A Editor | Part_Config
b Text Attributes | 'F’a: name o
part_nurnber
part_class
@ Text Editor part_designer _
. . . part_cost -
File Edit Opticn part_supplier
} A @ ABG part_description
‘1- E ol N ;D | E| F—--_] J O oF It part_keyword
part_manager
[Spart_name] part_material =
<left-click> to browse/select
<right-click> to inquire
“= Previous w Mext
6—‘ [ Cancel |
oK Cancel Cancel

Figure18 Embed Part Attribute

Note: User attribute links also could be added in template. Just keep the same attribute name.
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STEP 05/ When finishing the definition of link relationship, you will get the following result.

Unite Drawn
Part [($part_name]
Name Designed | [$part_designef)
:lrth [$part_number] Scale Checked [$part_managefr)
umber [$Sheet_dcbityed
Process Projection [[$Sheet_projection]
HattrlaIISF'ft-ML a
P, ZWSOFT COMPANY
Size Sheet |[$Sheet_sequence]/ h“lﬁlﬁl amount]

Figure19 Title Block in Sketch Level

STEP 06/ Back to 2D drawing level, then the customized title block is done.

iger

® Title block ZWSOFT
4 B Sheetl A4(H) (297.00 x 210,00 mm)
4 [ Sheet Format
=i Title Block

@ Table

+ Templates Title.Z3 - [Title block ZWSOFT] X

Part
Name

Unite

Designed

Part
Number

Scale

Checked

Projection I{GJEI'

Matarial

Quantity

ZWSOFT COMPANY

Slze

Sheet Il /1

I\flrllnnl

Figure20 Customized Title Block

Task3: Define the layer attribute

Select layer manager from the document aware toolbars, then create the new layers and set the

parameters, as shown in the image below.
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Q¢ @y ~ SE-@-HE-o o () bayer?0
| Layer Manager
'@ Layer Manager * LF ER
Active Mame On Frozen Color Line style Line width
Dimensicn o [ ] B arkbive - - -
- RN T : :
= View 7 G | RS - - -
4| I 3
Activate Mew Delete Import Export
OK Cancel Apply
Figure21 Layer Manager
Task4: Define the style attribute
STEP 01 Select style manager command from the ribbon toolbar or sheet manager.
Manager = EX
@ ® ZWSOFT
4 BB Sheet1| £ Style Manager... nsicn  Drawing | Tocls | Inguire
4 = Sh
B Insert Sheet g -+ & —
— i i L
[T Insert Folder
Method 1 Style Point.. Line.. Dimension.
& Tobl J | Grid Manager...
=l Dimensions On/Off
v | Drawing Border
Method 2
B Motes.
Properties...

Figure22 Launch Style Manager

STEP 02| Create a new style, such as linear dimension style. Then set the parameters and save
them, such as precision, text position.

STEP 03| Double click the new style to activate it as the default style.

STEP 04 Save the customized template at last.
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@ Style Manager L=
Current Document = | All " | ~Linear Dimension Style e
ANSL ZWSOFT 3 Activate o Mew Save Reset
a o Shylec
> . Point General Line/&rrow Text
P Line || || ~Layer ~Tolerance
oA Text
> [ Hatch @ Dirmension Type — Upper
3 [1 Annotations - Lower
b B Centerline/center mark Display [ Inspection
4 ';‘i_'\_.r_lillir:.ensions = Extension lines  Sidel and Side 2 I YK .
inear Di ion li Side1 and Side 2 -
Linear Style (ANSD |m.er?5|on ines  Sidel and Side Zero suppression
Linear Style (150) Precisien *X [ Leading zero [ Trailing zero
Linear Style (DIN) [] Show unit
Linear Style (JI3) ) Scale factor 1 Zero tol. display x:g:g;
Linear Style (GB) —Zero suppressicn
Li Style (ANSI)_ZWSOFT ... . :
N ’_<||_ |:ear | tyle (ANSD. Leading zero [T] Trailing zera Alt. Units
ngular .
b @ Radial/diametric ~Text Position [ Use akemate units
b 4 Arclength = Pasition Right
b Chamfer {'j g‘ {-“\ (3- (z Unit precision XXX
&
b @ - Hole callout - Tolerance precision XXX
—Preview Arrow Position | | XX - Alternate unit Millimeters
[ Ferce show dimensicn line 0
Linear value scale 1 Show unit
HUAA
e‘ set the parameters
Import Export all Apply Cancel oK

Figure23 Create the new Style

1.2 Create the Views

1.2.1 View Layout

-
=

Layout ribbon toolbar->View -> Layout

Use this command to create a 1 to 7 view layout of a 3D part.

STEP 01| Select one part, then define the layout view and other parameters, such as view label,

line attribute.
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Optional Advanced General Label Lines Comp General Label Lines Comp
Projection 1st Angle &7 w j TI'/ Individual Lines v
Layout ' = Visible
f:% Hidden ]
@ t{ﬂ ij I = [Tangent
|—| Tangent Hidden
O G W & e 2ae Visible 30 Curves —
s | """ L A Hidden 3D Curves -
@ ﬁ - Bend Line
' e, Hidden Bend Line
Vv '\'— Threads L |
- Hidden Threads
[ Inherit PMI Threads End .
[ Show scale S
coor
Scale type Use sheet scale =
@x/¥y 1 =| ; |1 - linebee ”
O XX 1 *  Linewidth -
Show label Layer Layer0000 .
Figure24 Define the Layout Parameters
STEP 02| The result is shown in the image below.
a | 7 | & | 5 i’ 4 3 | 2 ]
£ —— T —
L 1
D il il A —
—t - — | |
o
c
B
——
A - -_T_'-[-'H—F
= = |
E\I‘; T I [ | 5 + T l I ] z | T

Figure25 View Layout

14
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1.2.2 Standard View
i
Layout ribbon toolbar->View -> 5tandard

Use these commands to create a standard view from a 3D part.

STEP 01| Select the part from a file, then select the view from the drop-down list, such as top
view, isometric view, and define the view location, as shown in the image below.

View TOP -
Location 116.972,210.034 I AR

Figure26 Definition of Standard View

STEP 02| Set the other parameters, then click OK to get the view.

© — ®

VIEW TOP

VIEW ISOMETRIC
Figure27 Standard View

General View Attributes

PR

o BB

: Show hidden lines / center lines/ threads

(1)

(Z)E} A Ve

Eg. Turn on “Show dimension”, then get the result as show in the image below.

: Show dimensions / text / 3D curves /3D zero point from part

(Note: Sometimes, the default dimension positions are not optimal. So it is necessary to adjust the

dimension position manually.)
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©

|
|
) 7\ |
AN NS
25.00 | 28.00
78.00 # ! 1
25.00 I 28.00
()
NS
|

Figure28 View with Dimensions from Part

62.04

(3) L Inhert PME . check this option to show avaliable PMI on related views.

(4) Show scale and label

Refer to the image below to set the parameters and display attributes.

General Label Lines  Comp General Label Lines  Comp

| ’ff Lﬁ j f/ Scale prefix | SCALE -

= I = Scale format | XY v
A ,{?“ﬁ ]

Ptb ;’P ] e Alignment | AAXX | 2% AN
§| | Fan | |@| =l () Above view (@) Below view

k]
b

- ZW3D Simplex Roman + B U
Y% l{: \\5 ' AcBEYyLz
(] Inherit PMI Color EI Justification E -
Show scale 6 ==
Scale type Use custom scale - l + — 0.5
© X/¥ 1 of - it < 3((,})((%_ 1
0 X.X 1 : T
Show label XXXL— 0
Label TaP

Figure29 Setting of View Scale and Label

(5) Set line attributes
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Set the different line attribute (such as color, width and layer) for each line.

(6) Set component visibility

When defining the standard view, you could hide some components or inherit the

component visibility from part.

General  Label | Lines | Comp General  Label  Lines | Comp
Individual Lines - 4 = 10 Assembly ol
Visible - @ 01 Cover
Hidden ] . 03_Button
[Tangent . 02_Bottom B
Tangent Hidden 4 = 30_Board_assy =
1n.n‘i_sil::llva 30 Curves . 25_Curcuit_Board
Hldder! 3D Curves = ® U 2
Bend Line = Hide Component I
Hidden Bend Line @ 2 ‘
Threads o 2s Inquire
Hidden Threads B 22 sw
Threads End ] B 26 Encordor
#I:hdde:r? Threads End = . 24_scroll_wheel
_ & 14_LED1
Line type -IGMORE- = WENE
Line width — - @110

w113
Layer -BY VIEW- - -~ bt

[ Component visibility from part

Figure30 Line Attribute and Component Visibility

1.2.3 Projection View
a8
Layout ribbon toolbar->View -> FProjection

Create a view projected from another existing 3D layout view.
STEP 01| Select the base view and define the location of the projection view.

STEP 02| Set the projection type—1st / 3rd angle projection and set the view attribute.
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48 Projection £3 (— 1
v|[X] o

¥ Required II
Base view 47087 & g

Location ¥ % - .

¥ Settings

Projection 3rd angle ’

Dirmension type Projected &

Figure31 Projection View

1.2.4 Auxiliary

%

N
Layout ribbon toolbar->View -> Ausiliary

Auxiliary view is a projection view that is perpendicular from an edge of another layout view.

The horizontal or vertical edge is not suitable as the reference line.

Yiew Arrow
Offset ]

[
=
4

4
|

reference line

Arrow start 263141239327 ¥ % -~
Arrow end 286.888,210.189 ¥ % -
General Label Lines Arrow
Show view arrow
Header
-A r—n,
B =Y H |
- L

First arrow — -
4 _-.,I ]
Lse same style for two arrows

Figure32 Auxiliary View
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STEP 01| Select the base view and select the edge as the reference line.

STEP 02| Pick a point as the location of the view.

STEP 03| Set other parameters if necessary, such as arrow attribute, as shown in the above
image.

1.2.5 Full Section View

#he
Full
Layout ribbon toolbar->View -> 5ection -

Use this command to create a variety of section views of a 3D layout view.

STEP 01| Select the base view.

STEP 02| Pick points to define the section position.

Note: If two points are picked and full section line through the model, the full section view is
created. If more points are picked, the stepped section view could be created, as shown in the right
image of Figure 33.

STEP 03| Select a point as the location of section view.

STEP 04 Set other parameters if necessary.

NN
NN

NN

i |
| ZRn .
| |

%

/!: % AE

VIEW A VIEW B
Figure33 Full Section View and Stepped Section View

19
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Section Method

Trimmed Part section method shows a hidden line view of the entire part cut by the section

plane. Section Curves section method shows the cross section profile only.

¥ Section Method ¥ Section Method

Method Trimmed Part - Method Sect Curves -

-

|

|

. |

VIEW A-A VIEW A-A
_\

© Y. | .
h > VEN R > SN
- / - J

Figure34 Section View-Section Method

S&\\

N

_k\_\__

™ =
b >
™ F
L >

Section depth

After defining the section lines use this “Depth” option to further clip the model from the final
section view, then get a leaner section view. Full section and 3D named section view provide

this option.

Section depth 60 - Section depth 30 -

TR
N

|

| 60 30

Figure35 Section Depth
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Section Option

In part attribute form, the component section/hatch state can be predefined, as shown in the

image below.

'@ Part Attributes

standard | WUser  PartConfig  Driving Parameters  Physical
[] Mame Big-gear- shaft Derived from Big-gear- shaft
Mumber Create time iu May 20 09:32:27 2010
Designer Last moedified ‘ue Jun 06 14:46:03 2017
Manager Do not section [] Do not hatch
Supplier [] Do not listin BeM [ | Do not list in Root

Figure36 Part Attribute

When creating a section view of the assembly, these attributes can be inherited, as shown the

left image of Figure 37. If you want to redefine the component section state and hatch state,

unpick the section options, then right click the component to define, as shown the right image

of Figure 37.

¥ Section Option

Component section state from part

Component hatch state from part

4 ,:: Shaft_Bearing

@ & . 4{ do not section W

W Big_Keyl
¥ Big_bevel_

E@ Qil_ring

N Do not hatch ‘

l'fi Roller_bearing

EP Oil_ring

Ifi Reller_bearing

¥ Section Option

[ Component section state from part
[ Component hatch state from part

a = Shaft_Bearing
B Biggear—shaft
& Big_Keyl
. Big_bevel_gear
& Oil_ring
|. Roller_bearin
& Oil_ring

. Roller_bearin

Don't section

Don't hatch

Figure37 Section Option for an Assembly
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1.2.6 Aligned Section View

B
Aligned
Layout ribbon toolbar->View-> Section -

Use this command to create a section view in two directions.
STEP 01|Select the base view.

STEP 02| Pick the points to define the section line, including base points and align points, as

shown in the image below.

&8 Aligned Section 23
v X o
¥ Required

Base view #93762 i
Base point 313728192114

1 |dm

'__

-
!
4

& |@@ e
4

Base points 1 picked

S
Tt
v
Align points 1 picked v
v

Location 705.916,98.4238

Figure38 Define the Aligned Section Line

STEP 03| Define the view label location and set other parameters if necessary.

77

Figure39 Aligned Section View
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1.2.7 3D Named/Bent Sectio

Layout ribbon toolbar->View->

n View

B8 98
30 Mamed Bent
Section  / Section

Use this command to insert a named section created in the part using the Named Section

Feature command. The Named Section Feature must be created with a sketch.

“3D Named Section” command is used for the sketch that consists of lines with zero or more

bend points at 90 degrees. The function is similar with the stepped section view.

STEP 01| Draw a sketch.

STEP 02| Use Wireframe->Named Section command to create a named section feature.

(A

\_

-/

=

MNamed

E-’\J

Section ri___l : E/]

i

[}
I
| 1
n

D

I

N

Figure40 Create a Named Section Feature

STEP 03| In 2D sheet level, use 3D Named section view command to create the right section
view. When sections have been created in the part, 3D name option is activated. The

named section can be selected from the list.

2 3D Named Section

v | X

¥ Required

Base view #53674

30 name Hele Section
Location

¥ Section Method

Method
Close open profiles
Dynamic hatch scaling and angle

Trimmed Part

399.881,210 013 I g

E3

o (@

©

NN

V%

i_ | |

Figure41 3D Named Section View
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“Bent Section” command is used for the sketch that consists of lines with bend points at other
than 90 degrees. The operations of creating Bent Section view are the same as before.

Notes: On current version, Bent section view only provides the section curves section method.

SECTION A

Figure42 Bent Section View

1.2.8 Isometric Section View

Just like the 3D Named Section command, the section line needs to be defined in the part by
Wireframe->Named Section command. And the sketch line should be open.

STEP 01| Finish the preparation work: draw a sketch and create a named section feature.

STEP 02| Use Isometric Section View command to create the needed view, as shown in the

image below.

#. Isometric Section X4
v X o
¥ Required
File/Part
20 Sheet-4.73 v
Break Line

Dimension
[lsometric View |

broken
cylinder

[u ] »

%

4

Preview Off |

30 name I=o T
Wiew ISOMETRIC -
Location 23.004,120 623 K+

&
4

Figure43 Isometric Section View

24



Z\W 3D

1.2.9 Detail View

Qo
Layout ribbon toolbar->View -> Detail
Use this command to generate a detail view from other view.
STEP 01 Select the creation method and base view.

STEP 02| Pick the points to define the detail view border.

STEP 03| Define the view label location.

STEP 04 Set the scale factor for detail view and define the view location.

VIEW A - s
H/ g N
/ . / N\
1 I —
-. |
4 \ | /
+——t
~. L.~
VIEW A

Figure44 Detail View
1.2.10 Crop View

Crop
Layout ribbon toolbar->View -> View

Use this command to generate a partial view by trimming a drawing view with a defined

boundary.

STEP 01| Select the boundary type.

STEP 02| Select the view to crop (except detail view, define view, break line view).

STEP 03| Define the boundary to finish.
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Figure45 Crop View

1.2.11 Break Line View

Break
Layout ribbon toolbar->View -> Line

Break line view is suitable for the long-cylinder part. The diemnsion value is unchanged.

I 350.0 I

I P I S 3

Figure46 Break Line View
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1.3 Edit the Views

1.3.1 Redefine the View

After creating the view, refer to the following methods to redefine the view, including the

various section view, detail view and crop view.

o & e
Redefine Redefine Redefine
Method1: Layout ribbon toolbar->Edit View ->  Detail  Crop View  Section

STEP 01| Choose the suitable redefine command from the ribbon tab.
STEP 02| Select the view to redefine.
Method2: Right Menu

STEP 01] Right click the view, then select Redefine command to redefine the view .

(6 ‘~

3D View

[

T

|

| . -
[ £k Zoom Limit
1

2%

Figure47 Redefine the View—Method2

_

g ——

_;§_

Display mode

Display Label

1.3.2 Edit the Section Line

If the section view is created by “Full Section” command, the section line can be edited after the

view creation.

Insert the step points
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STEP 01| Right click the section line, then select “Insert step” option.

STEP 02| Point a point to insert the step.

o { =
h

(—
Gy Display Label N .
L

Reverse Direction

,.ﬁ
=
=
o
[T
5
©
_/

" & FErase
== EBlank L —_ ..J
¥ Entity Info
&  Attributes

Customize k _/l

Figure48 Insert the Step Point

STEP 03| Drag and drop the insert point to the suitable position to get a new section line. The
projection view is automatically updated.

P (7
f@ ) L..@_! )
TR 7N \e— | [t
=

. / - /

Figure49 Drag and drop the Insert Point

Reverse the direction of section line

Right click the section line, then select “Reverse Direction” option to reverse the direction of

section line. The projection view is auto-updated.
Remove the step point

Directly drag and drop the step line to align another line, then two step lines are merged into

one.
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L@": ) )
| @ — L_.._.‘...J
N ,z N S

Figure50 Remove the Step Point

1.3.3 Edit the View Attribute

You could quickly modify the view attribute with different methods after creating the view.
Method1: Right Menu

Directly right-click the view or right-click the view name in sheet manager, then select
Attribute command to edit the view attribute.

4o g 3, & B DrawingViewlTOF"lﬂ’_‘Ej [N

»| @8 Section View2 A-A

3D View 3 . B8 Section View3 A-A 3D View 3
£} Zoom Limit > [ Drawing Viewd TOf £ Zoom Limit
> B2 Section View5 C-C

%' Display mode 3 Display mode 3

d v | Display Label v | Display Label
VIEW A-A Display Scale Display Scale
Display others 3 Display others 3
v | Alignment v | Alignment
3D Measure 3D Measure
v | Component section from Part v | Component section from Part
v | Component hatch from Part v | Component hatch from Part
& Erase & Erase
E slank B Blank
¥ Entity Info ¥ Entity Info
& Attributes Ag Rename
Lkl Move View to Sheet & Attributes
Balloons link to BOM L_.J Move View to Sheet

Figure51 Edit the View Attribute-Method 1

ﬁ}
View

Method2: Layoutribbon toolbar->Edit View -> Attributes

STEP 01| Choose the View Attribute command.
STEP 02| Select the view and middle-click to confirm.

STEP 03| Reset the view attribute in the form.
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1.3.4 Edit the View Label and Scale

Use the above methods, you could edit the view label and view scales in view attribute form, as

shown in Figure 52.

How to quickly show/hide the view label and scale?

As shown in Figure 48, check/uncheck “Display Label” or “Display Scale” to quickly show/hide
the view label and view scale.

'@ View Attributes '@ View Attributes

Style undefined & Style undefined &)
General Label Lines  Text Section General Label Lines  Text Section
] Show scale Label prefix VIEW -
Scale type Use parent scale v Label format X -
@ XY 1 - / 1 - Scale prefix SCALE &
XX 1 - Scale format XY -
[] Show label Alignment ARXK ;; %
Label C

(7] Above view (0) Below view

Figure52 Edit the View Label and Scale

1.3.5 Move the View

Not any view can be moved to any position. Such as, the default projection view only can be
moved along the projection direction. For a projection view/ section view, follow these steps to

move it to any position.
STEP 01) Right click the view, then uncheck “Alignment” option.

Notes: Alignment option controls the view projection association.

STEP 02| Drag and drop the view to any position.

STEP 03| If you want to regain the original position relationship, check “Alignment” option and
move the view again.
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e OLY ]

30 View 3

Zoom Limit

\"\\Q\\
S

7

| |
}Gf?ij/// 7/ : : 7 Dfspla}-‘ mode b
// 7 é i 7 ]l I /) Display Label
' Display Scale
Display others b

v | Alignment
3D Measure

Compeonent section from Part

Compeonent hatch from Part

Figure53 Uncheck the Alingment to Move

1.3.6 Rotate the Base View

i,

&

Rotate
Layout ribbon toolbar->Edit View ->  View

Use this command to rotate view in place (only for base view) .

Select the base view, then adjust the parameters in pop-up edit toolbar.

[t |
& . . . . .
“: The view can be rotated by right mouse button when this icon is activated.

g ]
+ : The view can be moved by draging the middle mouse button when this icon is activated.

TOP oo @4l ¥ v f"—"@:‘\
=1
= ]

© :

Figure54 Rotate the Base View

31



Z\W 3D

1.4 Dimension

1.4.1 Set the Dimension Attribute

It's a good design habit that setting the dimension attribute before creating the dimensions.

STEP 01| Open the style manager to edit the dimension style.

Right click the 2D sheet object in sheet manager or directly select the Dimension

Attribute command from Tools ribbon toolbar.

Manager = £3 Layout  Dimension  Drawing | Tools
S T e g +w o= | &
| 4 BB Sheetl| & Style Manager... [ | (W] [} |
4 [ Sh Style Point... Line.. [Dimension.. | Annctation...
BB Insert Sheet Manager..
| Insert Folder Attributes
B Tabl v | Grid
-l Dimensions On/Off
' | Drawing Border

Figure55 Dimension Style Manager

STEP 02| Double click one dimension style to activate, such as linear dimension style. Or create
a new dimension style and set as the activated style.

@ Create new style = @

Name:  Linear Style (GB)_2
Based on:  Current Style v

[] Set as active style

| QK Cancel

Figure56 Create a New Style

STEP 03| Set the needed parameters and click “Save” button to save the modification.

STEP 04 Click “Apply” button to apply the activated style.
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@ Style Manager =]
Current Document | Dimensions " | ~Linear Dimension Style 6
4 i, Dimensions Activate Mew | Save | Reset
4 [~ Linear
Linear Style (ANST) o General Line/Arrow  Text
[Linear Style (150) - Active | ~Layer Tolerance
Linear Style (DIN)
Linear Style (JIS) @ Active layer e T 0L Upper
Linear Style (GB) - Lower
b A Angular  Display [ Inspection
> (& Radial/diametric Extension lines Sidel and Side 2 v .
b 4 Arc length Tolerance precision KK -
eeng Dimension lines  Side1 and Side 2 - .
b~ Chamfer N Zero suppression
I 4 Hole callout ST XX [] Leading zero [T] Trailing zera
b 11T Ordinate [ Show unit
Scale factor 1 Zero tol. display X:g:gs
—Zero suppression
[T Leading zero [T Trailing zero At Units
Text Position [ Use alternate units

- Position Right
!j ?2 fj {K‘- { Unit precision X..;!(X

Tolerance precision XXX

—Preview Arrow Position | | £ Alternate unit Millimeters
[ Force show dimension line 0
Linear value scale 1 Show unit
XXAM
Z ‘ Edit the parameters ‘
Import Export all 6 Apply Cancel oK

Figure57 Define the Diemnsion Style

1.4.2 Add Basic Dimensions

Use Quick Dimension Tool or other dimension tools to create the required dimensions.

Layout | Dimensicn | Drawing  Tools  Inguire
g, At v A g A ¢

Pl
Dirnension Linear Linear Linear  Angular Radial/Diam  Arc Hole
*  Offset Chamfer etric Length Callout
Dirnension

Figure58 Dimension Tools
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236

S5 4.8

/<—c 1SS

93.8 |
|

Figure59 View with Dimensions
1.4.3 Linear Dimension Mode

Fil

Baseline Use this command to create a 2D linear baseline dimension groups.

Al Baseline 3

v |[X] o .

¥ Required i —\
B I NN e

1st point #34235

& |&@
a

_|_
_/

2nd point #34227

. (]
Teat point 189033971125 % b - e

Points

B Settings

%

ez 15)

138.07

Figure60 Linear Baseline Dimension

Notes: In these images, the multiple 3or 4 markers indicate the additional dimension points.
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Continuous {Jse this command to create a 2D linear continuous dimension groups.

[Tl Continuous X

v | K

¥ Required o \

IO AN e

1st point #8477 &
p e (+ -I-)

2nd point #28438 i

Text point 483171,136.261 ¥ & -

Points D picked & (@ &
Setti

> wgs 29.27 93.8 15

I

Figure61 Linear Continuous Dimensions

[l

Ordinate Jse this command to create a 2D linear ordinate dimension groups.

11| Ordinate £3

v [ K (i) N
¥ Required

IO\

1st point #28136 & (+ +)

Text point 500.651,-307416 ¥ & - 0
Points 3 picked| & (@ 9 D
B Settings

—-138.07 —-108.8 —-15 o]

Figure62 Linear Ordinate Dimensions
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How to edit the linear dimension?

Add to Group

Dimension ribbon toolbar->Edit Dimension -> * I 1

Select a dimension in the group and specify a point to insert a new dimension into this group.

e |
. . . . . . Remaove from Grou
Dimension ribbon toolbar->Edit Dimension -> * 1 1 P

Select a dimension from a dimension group to remove.
% l Explode Group

Use this command to explode a dimension group. Then each dimension becomes an individual

Dimension ribbon toolbar->Edit Dimension ->

object.

1.4.4 Add the Tolerance

I

=XX
Maodify
Method1: Dimension ribbon toolbar->Edit Dimension -> Tolerance

Method2: Right click the dimension, then select “Modify Tolerance” command to edit.

= Modify Tolerance £3
v | X o
¥ Required
0 = sl —
= R “t;x| : . =
L, Entity 1 picked & 1M15.0 0.20
& Erase ; - 010
- ¥ Settings
& Elank
0.20
0.10

Figure63 Unequal Tolerance-Method 1
Method3: Modify the tolerance with Quick DimTool.

STEP 01] Right click the blank area in the ribbon toolbar, ToolBars->DimTool.
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Ribbon Appearance » [

Ribbon Tabs v Document Aware Toolbars  » |
Ribbon Panels » {E DimTool I
ToolBars d Layout

Styles »| Dimension

Customize... Drawing

P A
@ R M xxxx XXXX XX xxtxx [OXX] (XXX) XXX X XX XXX XXXX XXX

Figure64 Quick Dimension Tool

STEP 02| Select the dimension and then choose the tolerance type from the toolbar.

@ R M SCET xt“ﬁ xcxx [EXX] (KXX) XXX X XX XXX XXXX XX
Figure65 Tolerance Command

STEP 03| Modify the tolerance according to the requirements.

=% Meodify Tolerance B3
v | X L]
¥ Required
Entity 1 picked & 15.0 + 8%:‘1
¥ Settings P :
0.20
xtx}( =
oo

Figure66 Modify Tolerance-Method 2

ploll i

]

With Quick Dimension Tool to add dimension symbol

With quick dimension tools, we could quickly add some dimension symbols, such as: @ / R,
directly set dimension tolerance or precision.



Z\W 3D

g

Refer to the image below, select the “Tolerance zone” type, then click “Inquire tolerance”

button to inquire the tolerance zone. Select the suitable tolerance zone, then click OK.

How to add tolerance zone?

@ Tolerance Inquiry
2% Modify Tolerance £2 Shaft Tol | Hole Tol
L 4 x ﬂ' a Basic dim
=1 |1 Basic size <= 500mm 52
¥ Required
B 3 Tol code
Entity 1 picked & TIPS . PeYme———— &
¥ Settings m? Upper: 0021
s 9 KBmSPS:rEE s8] ta|ve|val Lower:0.002
o XXHT ~
s o0
1 [ common used tolerance zone o
Tel QK
B First choose tolerance zone
1| w2 el i -
— Cancel
— P52 ! > |- P52 kS —

Figure67 Define Tolerance Zone

1.45 Edit Dimension Text

s s
=

Modify Dirmension
Method1: Dimension ribbon toolbar->Edit Dimension -> Tet / Quick Edit

Method?2: Right-click the dimension, then select “Modify Text” command. At the same time, the

dimension editor form will automatically pop up, as shown in Figure 69.

= [ ABC

R R | |
B Blank

Figure68 Modify Dimension Text

This form allows the insertion of special characters, symbols and variables into the text string.

Notes: When using “Dimension Quick Edit” command, you need to manually open this editor form.
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., Dimension Quick Edit 23 @ Dimension Editor = 3R
—’ = File Edit Option
l. x o £ : < b R O . ABC @ BC
a o 8 o B | E| E:] 7 || Q | oef (78] &
¥ Required == :
Dimension #1304 & [Val] Variable Browser
v Dim Text
Text User text ¥ «w~ Previous o Next
Usertext | [Val] & @ v O — BT O ML L 9 Fm
(A Editor L P - PO=Nna ¥y + w
G Vv O @D ®Oee 06 HM |
OK Cancel

Figure69 Dimension Editor

1.4.6 Edit Dimension Attribute

4
=

Dimension

Method1: Dimension ribbon toolbar->Edit Dimension -> Quick Edit

Use this command to quickly edit partial dimension attributes, including dimension tolerance,

presion and appended text.

¥ Dim Attributes

Style

< Custom>

—Unit/Tolerance

XXXX -

Tolerance values come from part

+.01 0.20
XXX X. =]~

XX 0.20
120y X. I'_'i -

Appended Text

A K

KX AA

=+0.01
=0.00

@ Special Characters & Symbdis  EZ

Figure70 Dimension Quick Edit

Method?2: Right-click the dimension, then select “Attribute” command to edit all dimensions

attributes, including tolerance, dimension line /arrow,text ,font and so on.
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ie e e ABC
bt |1 oy g
iy LR iy B g

Eraze
Blank
Entity Info

<.j[ &

Attributes |

o

Activate Layer |

Figure71 Edit Dimension Attribute

1.4.7 Modify Text Point

Use this command to modify the text point location of a dimension or change the mode of text

placement (automatic / manual placement). The dimension text and extension lines will adapt

accordingly.

[=| Modify Text Point P
]

v | X

¥ Required

.
|

Dimension #25403

Text point [162.498,37.77 27 I R
¥ Text Placement
[ et |

] s

Figure72 Modify Text Point

Notes: Drag and drop the dimension to directly change the text point based on defined placement

mode.

1.4.8 Modify Dimension Points

Use this command to redefine a dimension. E.g. a dimension becomes invalid, you could use it

to redefine the dimension objects to make it valid.

I
Modify
Method1: Dimension ribbon toolbar->Edit Dimension -> Dimensic...

Method?2: Right-click the dimension, then select “Modify Dimension Points” command to edit.
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I} Modify an Offset Dimension 23
| X o
¥ Required
R e O Dimension #25403
e Line #55101 &
& Frase I_—’ Point #54012 &
& Blank Text point | 164.616,42.7146 ¥ & -
¥ Options
[ =
Text Usertext -

Figure73 Modify Dimension Points

g

It is highly recommended to use the quick method to modify dimension points or text position.

With Quick Dimension Tool to add dimension symbol

Move the cursor to the dimension/click the dimension, then drag and drop the control point or

text to a new position.

k control point { k /4!% k /

L Before / L After /

3 |

23.8

Figure74 Modification of Dimension Points
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1.4.9 Create / Modify Part Dimension

When creating 2D view, turn on the option of “Show dimension from part”, the view with part
dimensions is created.

¥¥ View Attributes = R
Style undefined L

T—a X D P F
® O 4 H
| D e E] A
-46.00+ A, Jg: S, show dimensions from part

[7] Inherit PMI

Figure75 The View with Part Dimension

Modify a part level dimension in a 2D view, then this new dimension value will automatically

drive the part geometry. At the same time, the other views will automatically update.

1oy
BT

Modify

Method1: Dimension ribbon toolbar->Edit Dimension -> FartDim

Method2: Right-click the dimension, then select “Modify Part Dimension” command.

" i I
[ w1 Modify Part Dim £E |

M ol

. ¥ Required T E
i [ = . . .5 ] - "
___—iI\P Dimension Blockl_Base_dS & :l._ _

Value &6 9 T E - |

¥ Settings |

‘ o [ Preview part dimensions cl—

&  Erase |Modi1‘_-,r Part Dimension

E Blank

Figure76 Modify Part Dimension
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1.4.10 Hole Dimension

Hale
Dimension ribbon toolbar-> Dimension -> Callout

Use this command to create one or more hole callout dimensions. First select the layout view
and then select the holes to add callouts.

STEP 01| Select the layout view and pick the holes (circle or arc).

STEP 02| Check the needed hole parameters.

STEP 03| Click “OK” button to finish. The result is shown in the image below.

v Settings @10.5 ¥ 32.0
/ L@ 18.0 ¥ 10.8
Callout Elements Dim Attributes

|| Quantity —I- /

(V] Diameter
(7] Diameter (D2) @200 ¥ 30'07

V] Depth
V] Depth (H2) @85 ¥ 20.0
(7] Thread Diameter M10x1.5 ¥ 9.2

(V] Thread Pitch Ligen % 7'5\

(V| Thread Depth

V] Angle

(V] Callout Label 2 >

(V] Multiple Lines
Figure77 Hole Callout Dimension

Notes: If you want to add the hole dimension on the projection view of hole, please use Label

command to manually create the hole dimension.

1.4.11 Align the Dimension

H
Modify Text
Dimension ribbon toolbar-> Edit Dimension -> Alignment

Use this command to align the position of a dimension with another dimension.

Select two dimensions. Then the first dimension is aligned to the second one.
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Figure78 Align the Dimension

1.5 Annotation and Symbol

1.5.1 Center Mark/Line

Center
Dimension ribbon toolbar-> Edit Dimension -> Mark

Use this command to create a center mark at an arc or circle, as shown in Figure 79.

bt
NN

Center
Dimension ribbon toolbar-> Dimension -> Line

Use this command to create a centerline mark between lines, arcs or circles, as shown in Figure

80. Also you can manually draw a centerline by picking two points.

Use individual extension

Check the option of “Use individual extension” to create the center mark /line with individual

extension. Then you could drag and drop the control point of the extension line to adjust it.
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-

|
o fET =T
B
Uze individual extension
Dash (4) 4.254534
Cherrun (B) 3.06324
Gap (C) 1.5875

_ Pl

Figure79 Center Mark

- " ﬂ . 1

Figure80 Drag and Drop the Extension Line

Center Mark
Dimension ribbon toolbar-> Dimension -> Circle

Use this command to place a centerline through a circular pattern such as bolt holes.

STEP 01| Select the center points of all holes.

STEP 02| Set the center mark type and define other parameters if required.

Dirm Attributes '
Style | «Custom= " =
-] [-A .
Ak

/TN D

[ Create as a circular centerline

[ Display extension lines

Uze individual extension \

Figure81 Center Mark Circle
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Create as a circular centerline

Check this option to show the circle instead of the center mark.

' ™
A B
zf-J I:E'\ ET—‘

/4 \

Create as a circular centerline
[T Display extension lines

Uze individual extension

Figure82 Center Mark Circle-Circular Centerline

1.5.2 Datum

oY

Datum
Dimension ribbon toolbar-> Annotation -> Feature

Use this command to create a datum feature, which can be used in Feature Control Symbol.

STEP 01| Set the label text or use the default value.

STEP 02| Select the target entity.
STEP 03| Pick a point to locate the text.

STEP 04 Set the display parameters according to requirements.

General Lines Text

—
A,

Scale factor 1
==l
Display Type @

AALL U2

R
Arrowhead size 3.0632

Figure83 Datum Feature

Display
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1.5.3 Feature Control Symbol

TN

Feature
Dimension ribbon toolbar-> Annotation -> ontrol

Use this command to create a feature control symbol.

STEP 01| Define the FCS text by the editor.
STEP 02| Pick points to locate the FCS text..

STEP 03| Define other parameters, such as additional leader points, display type.

== Feature Control 3 — | O
]
v || X o O #
1
¥ Required /L
FCS text X001 [V e[ Vick kB [Box] | 2 < | #
Location 2 picked ¥ & - ©|= )
@ Feature == mbel Editor. =1
¥ Leader Points
Motation 7
=z
Leader pts b’ - /__,_,_
Symbag. | Tolerance 1 Tolerance 2 Datum
i i i | |
¥ Dimension Attributes 1w - ~ | F £ A 15 g L L5
Style undefined | =
- E E
General Text F F
Display
— Motation Text2: +
Preview
Scale factor 1 [ [0.01]A]B]
Combine symbols %
oK Cancel
.‘Q Enable JTolerance 2 ~ ~ -

Figure84 Feature Control Symbol Defination

Figure85 Feature Control Symbol
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1.5.4 Surface Finish Symbol

Surface finish represents the machining quality of part surface. So in 2D view, it is required to

select the edge to define the surface finish symbol.
STEP 01| Pick a point to locate the symbol.
STEP 02| Define the orientation angle or lead point if needed.

STEP 03| Select the machining type and set the value.

' Surface Finish

v | X o
¥ Required
Ref. point 217.2%6,93621 | ¥ L v
¥ Settings

AR
Crientation a0

Lead. point

V|
i

General Attribute

Symbol Type 3 'iz

Machining required

i
4 | b

Lnnding

Symbol Layout

3.2

Mone -

Figure86 Surface Finish Symbol

1.5.5 Label/Text

P
1]

Dimension ribbon toolbar-> Annotation -> Label

Use this command to manually create a label. Take a counter-bore hole as example.

STEP 01| Pick one or multi points to locate the label.

STEP 02| With editor to input the dimension text, as shown in the image below.
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Click 'ﬁj, add hole dimension D1 value(32); then click v ,add hole depth H1lvalue (95); line

feed; click ““and 'ﬁj, add hole dimension D2 value (52), then click v ,add hole depth H2
value (5).

'@ Dimension Editor L= B

File Edit Option

El ~~ 4 [E v ol s

[Vick]e32 [Vak]{95
[Vack]y[Vack]c52 [Vack {95

“= Previous = Mext
@ ¥ O - oO0ON /N L L ° m
Ll B PO=Nna F + w
Vb o POOEDOR | e

lTl Cancel

Figure87 Define Dimension Text with Editor

STEP 03| Click OK to get the label, as shown in the image below.

W Label E3
M

| K 0 M
¥ Required

Locati 3 picked ¥ & @32 ¥95

aeenen pieee v Lig52 ¥5

Text 15 [Vac]y[Vadd]e52 [Vack]is &

¥ Leader Points

Leader pts b -

¢ Dimension Attributes

Figure88 Hole Dimension Label

Leader pts option: Select points to locate additional leader arrows.
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1.6 Table

1.6.1 Create a BOM Table

ixl

Dimension ribbon toolbar-> Table -> EBCM
Select the view to create a BOM table, including detail and section view.

Let’s see the image below, this is an assembly including some components and subassemblies.

Show Components

4 . Assembly
. () Valve_housing
. Valve_yoke
Valve gasket
4 [7] = Hex_boltx6
B Washer
- Screw MEB
i ‘u"alve=sea|
4 [¥] & Handle Set
4 E. Body
- Value_body
- Set_screw
. Valve_handle
== Patternl

Figure89 Assembly Model

¥ Level Setting

0 Top-level only
[ Parts only
() Indented

Max traverse depth
Level Setting

Top-level only: only list out parts and sub-assemblies excluding sub-assembly components

Parts only: only list out all parts including the one from all sub-assemblies, but not list
sub-assembly. Each subassembly component is an individual item.
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0) Top-level only 0 Parts only
=] Name Quantity ([m] Moame Quantity
1 Hamndle Set 1 1 Scraew MB (=]
2 Hex_bolt =] 2 Set_screw 1
3| Valve_gaosket 1 3| Volue_body 1
4 |Valve _howsing 1 4| Valve_gasket 1
5 Yalve_seal 1 S| valve_harndle 1
= Valve _yoke 1 & |valve_housing 1
7 Valve _seaal L
8| Valve_yoke 1
= Woasher [=3

Figure90 Top-level only VS Part only

Indented: list out all the parts and sub-assemblies and their components, and more further

controls are provided. Three methods are provided to define ID, as shown in the image below.

(@) Indented (0 Indented (@) Indented
Mo numbering L Detailed numbering L Flat numbering =
1D Maim e Quamnmtity I M emme Quiamtity I Marme Quamtity
1 Hamdle Set 1 1 Harmdle Sat 1 1 Hamdle Sat 1
Body 1 1.1 Body 1 2 Body 1
Set_screw 1 1.1.1 Set_screw 1 3 Set_screw 1
Value_body 1 1.1.2 Volue_body 1 4+ Yalue_body 1
Valve _Farndle 1 1.2 Valve _handla 1 5 Vvalve _hondle 1
2 Hex _balt & 2 Hex_bolt =] =] Hex _bolt =]
Scraw MB 1 2.1 Seraw MEB 1 7 Scraw MB 1
Washear 1 2.2 Wosher 1 a8 Washer 1
3| Vvalve_gosket 1 3 Valve_gasket 1 9| Vvalve_gaskeat 1
4 (Valve_housing 1 4 |Valve_housing 1 10|Valve_houwsing 1
=) Valve _sesal 1 = Valve_saal 1 11 Valve_saal 1
= Valve_yoke 1 (=1 Valve_yoke 1 12 Valve_yoke 1

Figure91 Indented Level

Max traverse depth: This option is to define which assembly level BOM should read out up to.

When this option is checked and the value is set as 2, you will get the following BOM table.

(@ Indented

Detailed numbering &)

Max traverse depth 2 -

Mame

Scm t'lt_'.r

Harmdle Sat

1

Body

Valve_handle

Hex_bolt

Screw MEB

WoaskHer

Valve _gosket

Valve_housing

Valve_seal

Valve_yoke

1
1
=)
1
1
1
1
1
1

Figure92 Different Traverse Depth



Z\W 3D

Item Numbers and Template

w Item Numbers ¥ Template
Starting ID 1 .| & [1] Template !
Order Order by name |T| ¥ Table format
Regenerate IDs after sort Available Selected
Urder as assembly Source file pjil D
Size P Mame
Length « Cost
Width Murmnber
Height Quantity
Area « | Material
Legend -
Stock Size
4[] »
Attributes... Default
Sorted by Quantity 5 %l

/| Sort when regenerating
- System defined - User defined

Figure93 Item Numbers and Template
There are three different methods to sort the table ID.
Order by name: Based on the part name to sort the table ID.
Order as assembly: Based on the components insertion order to sort the table ID.

Regenerate IDs after sort: When table order is changed, IDs will be regenerated. The table

order is controlled by another parameter, as shown in the image below.

Sorted by Cuantity & ;1
/| Sort when regenerating

o Mame Quantity o MName Quantity
1 Hormdle Set 1 1 Valve_yoke 1
2| Valve_gasket 1 2 |Valve_housing 1
3 |valve_housing 1 3 Valve  seal 1
4 Valve_yoke 2 4 Hamdle Set 2
5 Valve_seal 2 5| Valve_gasket 3
& Hex_bolt & (3 Hex_bolt &

Figure94 Table order

Notes: If the option of” Sort when regenerating” is unchecked, the table order will not change, so
IDs also will not change.
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All available part attributes are listed in here, including black system attributes (such as
Legend) and green user attributes (such as Stock Size), as shown in Figure 95.
3 -

1 :Add or delete the attribute ~ ~ : Rearrange the sequense of the attribute

D Name Quantity| Material |Mass[kg]|Legend

1 Harmdle Set 1 Alumirmum 6.427 T'

2 Hex_bolt 6 Steel-grey| 0.015 T

3| Valve_gasket 1 Rubber 0.021 O

4 |Valve_housing 1 Brass—cast| 11.983 “

5 Valve _seal 1 Rubber 0.003 Ry

6 Valve_yoke 1 Steel-cast 2.122 0

Figure95 BOM Table

BOM Filter

Use BOM filter to set up some conditions to generate a specified table.

Part attributes and customized attributes are available for this filter condition.

¥ Filter

BOMfilter | EditBOM Fitter | || ' BOM Filter = 5=
BOM filter
Attributes Operator Condition value

Components

4 ,E. Assembly
. Valve_housing Keywords "= - Standard Part Add

W Valve yoke |Keywords != Standard Part | Delete
] Valve_gasket
e Hex_bolt Submit Edit

. Valve_szeal Clear

© i Handle Set
o2 Hex_bolt

- i Hex_bolt

m
> e Hex bolt Ok Cancel

: o Hex_bolt

o Hex bolt

Figure96 BOM Filter
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1.6.2 Edit the Table

Move the cursor on the table, click - to activate the table editor. Click any cloumn or any
row to get the table cloumn/row editor, as shown in the image below. Then you can add/delete

the column/row, set the text alignment,text attribute and so on.

Table 23

[l [ E[E] [ =]=]= || D] =]

i

Name Quontity|Part Maoterioll Mass[kg]
1| Handle Set 1 Steel 45§ 6.427 3
Hex._bolt 6 Steel-grey 0.015 ?
Volve_gosket 1 Rubber 0.021 0
Valve _housing 1 Bross—-cost 11.983 g
Valve_seal 1 Rubber 0.003
Vaolve_yoke 1 Steel-cost 2.122 ¢ <>
¥y Table Column i 2R
c | mE o | = ; v
= "z B ahn| e [ﬂ] E ¥ 3 = | o ‘ M 8 Normal
ZW3D Simplex Roman "l3os |B| I U| O =l & ||| o

Figure97 Table Editor
Q1. Edit the Column Name
A1: Double click the column head to edit, such as Material ->Part Material.
Q2. Edit the Column Attribute

A2: Right click the column head, then select the attribute to edit, such as value precision.

ﬁ B Toble Atriutes o &
i {u]
Part Material MC]SS[k g g 18 ) ermd Style < Custom: T
T I Sync BOM Table with Part Attributes E ‘ T
Aluminum 6.427 of]  Insert Table :"ira
—Fon
[  Export Table
Steel—grey 0.015 ZW3D Simplex Roman ¥
Cut =
4o B I U|oQ|«
Rubber 0.0217 |B Copy
AaBbBY yZz
Brass—cast 11.983 & dek Color ¥ LAVER
¥ Entity Info = 0 ol
Rubber C.003 |5 aurbuss PN o
. —Alignments
Steel-cast 2.122 | Adieelye L
¥ Layer On/Off WRCHIER
Herizontal Center T,
Vertical Half "
Mumber
3 ~| Zero 020 _
’;reclswon KXX Gis e |
L = .

Figure98 Edit Column Name and Attribute
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Q3. Edit Cell Value

A3: Double click the cell, then “Yes” button to unlock the value to edit. Such as changing the

material of one component.

Part Material |}

Q Aluminum

Part Material

Q Steel 452

% ZW3D

The cell is locked, it may be linked to
some objects or an external file,

Do you want to unlock it and continue to edit?

O - | ~

Figure99 Edit Cell Value

Q4. Sync BOM table with Part Attributes

A4: Move the cursor on the table, then right click - ->click this command “Sync BOM table
with part attributes”. Then you could check the part attribute in modeling level by Tool

ribbon tab-> Attribute->Part attribute.

Sync BOM Table with Part Attributes § Material

Inzert Table

[ Export Table

¥ Cut
B Copy
B Elank

Figure100

==l 454

el—grey

ubber

gss—cast

ubber

:El—ﬂ::l:lﬂ t

BB Sheetl A4(H) (297.00 x 210.00 mm)

E= Sheet Format
4 @ Table |3y it @'_‘,I

B BoMm

& o Drawin i Sync BOM Table with Part Attributes

of] Insert Table
A Export Table

Sync BOM table with part attributes

'@ Part Attributes

Standard User Physical
Source Allin current - __J
Material  Steel 45 B
Density 25430000 e-006 kg T/ mm ¥ "3

Figure101 Updated Part Attribute
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Q5. Edit Table Header

A5: Move the cursor on the table, then right click - ->Select Insert -> Head Row. Then you

could merge the cells or edit the header cells, as shown in the image below.

o Insert header row
1D Name Quantity|Part Material| Mass[kg] |Legend
1 Hamdle Set 1 Steel 45§ 5.427 Fi
B Cell P &3
g2 m] E[E] 2= =] [m]m= Normal  ~
ZW3D Simplex Roman 306 | B I U O = S N‘.&’
> 9 Merge cells
1n] Namea Quartity[Part Materiall Mass[kg] {egehd
Prpperty
ID Name Quantity|Part Material| Mass[kg] |Legend
1 Harmdle Set 1 Steel 45§ 5.427 F
@ Editheader cell
Property
1o Name Quantity . Legend
Fart Material| Mass[kg]
1| Harmdle Set 1 Steel 45# B.427 7
Figure102 Edit Table Header

Q6. Table Template

A6: Select the whole table, then you could use “Save as Template...” to save this table header as

a BOM template. Then when you create a new BOM table, you could import this tmeplate.

&

| =2
o]

&

= ¥ Template
I P
; . Template @
Sync BOM Table with Part Attributes
Insert Table ty ¥ Table format
—
Export Table Far Available Selected
= Class - iy
Cut Designer Marme
Copy =2 Supplier Cost
Manager " Number
Remarks ¥ Cuantity
Description Material
e S
Restore Original Yalue Br KE}"II.ﬂ.I'DrdS
Derived Frot
Save as Template... Start Date .
Customize = E:"i'l_}ate -
Figure103 Table Template
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Q7.Import/ Export Table

A7: As shown in Figure 100, the table can be exported by “Export Table” command and saved
as an excel file. Then you could edit this excel file. After editing, the table file can be
imported into 2D sheet, as shown in the image below.

4 BB Sheet? A4(H) (297.00 % 210,00 mm)
[ Sheet Format

B Table

B User Table
EpoW Tabl
_ aule 4 BB Sheet? A4(H) (297.00 % 210.00 mm)
B Hole Table i [ Sheet Format

| Electrode Table a B Sheet? A4(H) (207.00 x 210.00 mmm) 4 B Table 4 5

[ Sheet Format = BOM_TE--_'——/'

@ Regen All Tables 4 @ Table of] Insert Table
B Import Table o | i BOM_Table [ Export Table

Figure104 Import & Insert Table

1.6.3 Auto Balloon

Auto
Dimension ribbon toolbar-> Annotation -> Ealloon

Balloons are automatically generated in a view based on component visibility. Balloons are
inserted into the appropriate views without duplicates. You can specify that the balloons follow

the assembly order or are numbered sequentially.

Select the 2D view. The default balloon text is ID.

Notes: The Lower Text option is activated when the balloon type is circular split line.
Set the layout parameters. Pattern type is defined as square type.

Set balloon type as circular and use the second quantity type.

Click OK to get the result, as shown in the image below.
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Yiew #1286713

Text D

Lower Text Material
—

P g | akp

Pattern type Square
Display
Balloon type Circular
Cuantity

1
® @ e § P
Denoctation X

Figure105 Ballloon-Result1

You could try other parameters to get the different balloon display effect, as shown in the

image below.

Eozasoia) [Eoz4aooia) [Eozssoss
Steel Aluminum Steel
]

DIND12-MBx1x35=12.9

b (DINS 12 _MEx25_8.8_vF
A Stesl = )/
"
NORDLOCK —ME

Ec205018
\_Steel

Figure106 Different Balloon Display

More Layout Parameters

If there is a BOM inserted in drawing sheet, these options are activated.

Arrangement  Mearest -
Only for compenents in BOM

Only for items without balloon

“Only for components in BOM” option is to control whether the excluded components from
BOM should be labeled. If the excluded components are included, a * character will be used as

their ID which you can modify to the one you like.
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“Only for items without balloon” is to label the components which are not labeled in any other

views.

STEP 01| Create the top view and the projection view on the left, as shown in Figure 108.

STEP 02| Create the BOM table with “Part only” method.

STEP 03| Select the top view to create the balloon.

STEP 04 Select the projection view to create the balloon. The parameters are set as below.

STEP 05| Get the balloon result as shown in Figure 108.

¥ Required ¥ Layout

View 692009 ¥ ©
radadin)

. o . PO P PP

Lower Text 1D Pattern type  Sgquare

Offset 10

Skip sides Mone
Arrangement  Mearest

Only for components in BOM
Only for items without balloo

Figure107

¥ Settings

Style = Custom: =

General Text
Display
Balloon type | Underline &

-

Scale factor 1

Definition of Parameters

VIEW TOP

Figure108 Balloon of Cross-views
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Relations between Balloon ID and BOM ID

How the balloon ID is generated from BOM ID can follow the rules listed below:

1) If no BOM has been generated from any view of an assembly, balloon will label every component in

part level with IDs that follow their assembly sequences.

2) If a BOM is generated from a view of an assembly, when “Arrangement” is using “Nearest”, balloon ID

will use BOM ID to label components.

3) If a BOM is generated from a view of an assembly, when “Arrangement” is using “CW” or “CCW”,

balloon ID will be generated and BOM ID will change to the new ID.

4) If a BOM is generated from a view of an assembly, when “Arrangement” is using “CW” or “CCW” and
“Keep the item numbers” option is checked, balloon ID will follow BOM ID but re-place them in

defined style.

5) If several BOMs have generated within one sheet, “Balloons link to BOM” from the right-click menu of

a view can be used to link the view to a specific BOM, then balloon ID can inherit the BOM ID.

1.6.4 Balloon

-0

Dimension ribbon toolbar-> Annotation -> Balloon
Pick drawing entities to manually create the balloons by with command.

You can define multiple base points and multiple leader arrows to generate the same balloon

text, as shown in the image below.

The parameters of dimension attributes are the same with Auto Balloon command.

Figure109 Manual Balloon
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1.6.5 Hole Table

Dimension ribbon toolbar-> Table -> Hcle

Use this command to create a hole table based on a layout view that contains real holes and
user-defined holes. Take this model as an example

. 3D Wireframe

.Frnnt—facing holes . Back-facing holes .E.Il:u:ulean hales

Figure110 Hole Model

STEP 01| Create a top view based on this model.

Figure111 Top view-Hole

STEP 02| Select the 2D view and give an name for the hole table.

STEP 03| Pick a point as the base point. Then, in hole table, the x & y coordinates of the hole will

be defined relative to this point
STEP 04 Set the hole filter. As default, only front-facing holes are selected.

STEP 05| Set other parameters if required. Such as check the option “Combine same size”.
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STEP 06| Click OK. Then pick a point to insert the hole table. The result is shown in the image

000

ID | X—cemter |T—carmter Sizre

— N 1| -o0.00 47.51

@ @ e @.,——@ 2| BB.97 47.51 | #B.50 ¥ 20.00

” @ 3 5560 co0 |w#1z.00 ¥5.00
@__ﬁg @ ¢+ 4| BB.o7 0.00
x 5| -3.22 33.85
&| =2z2.19 33.85

@——-ﬁ t—-— #3300 F12.00
i 7 -3.22 13.66

A
@) B @ @ o @ 8| 9212 13,66
\ 3 y a| zo0.sa 2377
@ 8.00 THRU

10| 57.53 23.80

Figurel112 Hole Table

Hole Filter

Backfacing holes
Hidden holes

When only “Backfacing holes” option is checked, back-facing hole features based on this view

plane are selected. If the back-facing hole is not a thru-hole, it will not be selected.

When “Backfacing holes” option and “Hidden holes” option both are checked, all back-facing
holes are selected.

Boolean holes

Check this option, the imported holes and Boolean holes will be included.

Notes: Checking or unchecking these three options does not affect holes that you have already

selected for the hole table. This option has no effect when selecting user-defined holes.

So on current version, after resetting the hole filter, please redefine the view option. Then the

selected hole features are updated, as shown in the image below,
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¥ Required
View #125754 &
Mame Hole & )

Base point 123.601,305.801 | % &

s ™
Ic
@
©
©

¥ Hole to Toggle

; 3
# Hole Filter @ @ =

Hole features | 20 picked

b,
<
User-defined o o
F o= \l —
- ©0® o O
Backfacing holes D \‘:.-1_,_;} o
Hidden holes \ J

Boolean holes
[] Uzer-defined centered on feature

g

STEP 01) If some circles are drawn in part level, you could edit the view attribute to show them
firstly. Right click the view-> Display others-> Show 3D Curves from Part.

Figure113 Reset Hole Filter

How to add the user-defined hole into hole table?

See the image below, there are two circles. Circle2 is concentric with one hole feature.

Display others "||og] Show hidden lines ( @ ® h
3D Measure #} Show Center Lines @ =
Component Visibility from Part | (| o) Threads o £ o

©)
Show Dimensions from Part @ 2 G—)

Fent
L

& Erase =
B Blank A Show Text from Part & $O ; o

¥ Entity Info M Show 3D Curves from ffﬂj °
&  Attributes L= Show 3D Zero Point ~ Q@ @ g

Figure114 Show 3D Curves from Part

STEP 02| Activate “User-defined” option, then the circle1 can be picked. If you want to pick
circle2, the option “User-defined centered on feature” should be checked.
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# Hole Filter é y = \|| ™ A
£
Hole features 10 picked ¥ @ "@
t—T-'l
User-defined | 2 picked v ¢ ’ = ©
o)

[] Backfacing holes @ 2 @
] Hidden holes /"" |

[] Boolean holes ‘/ @ X 9 ©
User-defined centered on feature {éﬂ F'_Ej @ -
Show origin indicator L - St

Combine same size

Figurel15 User-defined Hole Feature

STEP 02| Pick all hole features and add user-defined holes for hole table. The result is shown in

the image below.

D |¥=-cantar|Y-cantar Sire
10 1 -0.00 4781
2| 8897 47.51 | ¢8.50 ¥20.00
b o.00 0.00 Lig12.00 ¥ B.00
& 88.97 .00
j_ ) 5 =3.22 33.85
.‘B . @ | =z.@ 33.B5
| # 300 ¥I12.00
o 7| -3=22 135.66
) = 8| sz.ae 13,66
. a ﬂ . ) 30,54 23,77
@ﬂ fé} _® 0| 57.53 23,80 @8.00 THRU
@ ~ | +8.80 48,48 @ 7.50 THAU
2| ammo | —oces | VE0.00xe0
a a - e 3 8,26 o227 # 4.00 ¥F10.00
| - . | &7.0B zo.rz | LB B.00 F2.00
i 5| 878 &8.83
73} ﬁ { z e\ "@ .| &.78 Taes | T400 TiZ.oo
-
A y 7| BB.43 -2.24 §4.00 ¥30.00

18| G643 A9, FE

19| 34,49 =124 @ 5.00 ¥20.00

20 19,49 43.78 12,00 ¥ 20,00
22 @ 21| 14.5a .23 & 10.00

22| 3D.ma 23.77

Figurell6 Whole Hole Table
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1.7 Case---2D Drawing

Figure117 Casel--- 3D Model

STEP 01| In modeling level, select “2D Sheet” command and “A2_H(ANSI)”template to create a
2D sheet.

STEP 02| Create a standard Top view, as shown in the image below.

aellé¢ 99 U@ @-LUH B -

® 2D Sheet ¥¥ Select a template... =t
Y CAMPlan Al .
[Default] <

AD_H{AMST)
o Al _H(AMST) B
| A2_H(ANST) -

A3 _H(AMST)

Figure118 Top View

STEP 03| Use “Full Section” command to create two section views. The parameters are set as
shown in the image below.
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o .
¥ Section Method T =
Method Sect Curves i I I ]
Close open profiles I I
Dynamic hatch scaling and angle ' -

Inherit section from base view _
Location Mone hd
Dimension type Projected &)

Figure119 Section Views

STEP 04| Drag and drop the end point of the section line to get a better position. And right click
the section line to select “Display label” command.

TIT

1 Display Label
i o Reverse Direction

VIEW A vViEw B8

A B

C. L.

Figure120 Section Views with Label

STEP 05| Use “Broken Section” command to create two broken section views on top view.

il Broken Section 23 ,ﬂ‘\

| 1 [+| I_P B
| K i} . . |
¥ Required

OO

Base view #107163 %

Boundary 2 picked Yy & - I

Depth Point - |

Depth point | 450.866337514 % & - L'-
Depth offset 0 2% - B

4

Figurel121 Broken Section Views

STEP 06/ Open the Style Manager to make some modifications, such as value precision of linear
dimension, text format of chamfer dimension, text shape.
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—Display — Text Shape Text Position
Extension lines | Sidel and Side 2 - 306324 ‘l { ‘- ‘- -F
Dimension lines | Side1 and Side 2 b 1
Precision XX r | XX3 Text Format 1 ||
[] Show unit XX-L 1
_Jl Arrow Position |¢—PI—XX -
Scale factor 1 0.25
—Zero suppression ‘-\ 0
Leading zero [T Trailing zero xxxl
— Text Position
“ltalaaa
Figure122 Dimension Style
STEP 07| Create the dimensions, annotations, hole labels, surface finish symbols and so on.
[=] 1 380
? l""B
7> I
s g M Q
1w | _________g_____________lﬂ | IJ—IA 0
. y s W\“’
=1 " = I =1
1
! N\ @6.8¥22.25
s LB }2 o0 LKB.OF6.0
cz0 49.0 ? 40.0 -
0.0 130.0
394.0
3 1o
od
+1
Q
VIEW A VIEW B
Figure123 View with Dimensions

STEP 08| Set default drawing units. Tool ribbon toolbar->Setting->Preference

Units

'@ Drawing Settings

Type of projection | By Standard

FrFm =
Mass units grm L
Grid spacing 5

Rezet

OK

Cancel

Figurel124

Drawing Setting
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STEP 09 Edit the title block. You could add some part attributes with text command and editor.

oravn [ Bpart _desigARér s [$part_name]
cveck [$part_manggEr ™ [$part_number]
R SIZE CAGE CODE DWG NO REV
Material [$Fheet_site]
$ part_mate r[im}eet_scde] l“’E'GH‘[WG't—MOﬂIS#ﬂ@LMMt]

Figure125 Edit the Title Block
Notes: Some texts are overlap when defining part attribute. But it doesn’t matter.

STEP 10| After editing, when back to 2D drawing level, all information has been linked with

part attribute.
E— Roy FILE NAME CoseT—Big Shaft
creck Dave GESNARE DKBA28-06
LZWSOFT
ISSUED
SIZE CAGE CODE DWG NO REV
Material A2(H)
Aluminum scaLE %1 IwEch1 135145 gm Esnasr 1 oF %

Figure126 Title Block
STEP 11 Add some technical requirements by text command.

STEP 12| The final 2D sheet is shown in the image below.

PR [ o 1 I I & I I I I
380 94 D[20.06[A] 11 36,0
e 7 B
g L 3
1 - L E s
H l o AN
y Ty Lg gemT2zas
c2o| aso 3 M oo [f20 LWBOFED
oo 130.0
(] 394.0 -
o =

] VIEW A -
| | = [ Ceeiy et H
TECHNICAL REQUIREMENTS: i e
UNSPECFIED RADI MUST BE 15MM, - ZWSOFT
L | | T ¥ | | I

Figurel27 2D Sheet of Part
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